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Al Direttori di Dipartimento,
Scuola, Biblioteca, Centro

Alle Segreterie di Dipartimento,
Scuola, Centro

Ai Dirigenti

Ai Direttori degli Uffici

LORO SEDI

Trasmissione via e-mail

OGGETTO: Accordi tra Pubbliche Amministrazioni per attivita di interesse comune -
Sottoscrizione con firma digitale (art. 15, comma 2 bis, della Legge 07.08.1990, n. 241,
cosi come modificato dall’art. 6, comma 5, del D.L. 23.12.2013, n. 145, convertito con

- emendamenti dalla Legge 21.02.2014, n. 9) - Assolvimento dell'imposta di bollo e di

registro

Facendo seguito alla Circolare prot. n. 27793 del 27.06.2014, con la quale sono state
ilustrate le modalita di stipula con fima digitale degli accordi tra Universita e Pubbliche
Amministrazioni per attivita di interesse comune, e con cui si specifica che la sottoscrizione
di accordi tra Pubbliche Amministrazioni deve avvenire - a pena di nullita - con firma digitale,
si rende ora necessario definire le modalita di assolvimento delle imposte di bollo e di
registro per tale tipologia di accordi.

La sottoscrizione in forma digitale non softrae infatti i menzionati atti alle imposte di
bollo e di registro, qualora tali imposte siano dovute ai sensi della normativa vigente in
materia. Tale tipologia di sottoscrizione — determinando una dematerializzazione degli atti —
impone invece una particolare modalita di assolvimento delle menzionate imposte, le cui
procedure, sulla scorta di quanto indicato dallAgenzia delle Entrate - Ufficio Territoriale
Venezia 1, vengono di seguito riportate.

IMPOSTA DIBOLLO

It Decreto del 17 giugno 2014 del Ministero dellEconomia e Finanze, relativo alle
modalita di assolvimento degli obblighi fiscali per i documenti redatti in forma digitale, con
riferimento alle modalita di assolvimento dellimposta di bollo, allart. 6, commi | e H, dispone
che: "Limposta di bollo sui documenti informaticl fiscalmente rifevanti e comisposta mediante
versamento nel modi di cuf alfart 17 del Decrefo Legisiativo 9 lughio 1997, n 241
versamento unitario] con modalita esclusivamente felematica. Il pagamento dellimposta
[...] awiene in un'unica soluzione entro 120 giorni dalla chiusura dellesercizio”.

In concreto, l'assolvimento dellimposta di bolio per gli accordi stipulati in forma digitale
fra PUniversita e altre Pubbliche Amministrazioni, se dowuto ai sensi del D.P.R. 26 otiobre
1972, n. 642 e successive modifiche e integrazioni, dovra avvenire con versamento
felematico, in un'unica soluzione, enfro | 120 glomi successivi alla data di chiusura
dell'esercizio finanziario dell Ateneo (31 dicembre di ogni anno).

Per ragioni di efficienza ed economicita, l'assolvimento di defta imposta sara
effettuato in maniera unitaria a livello di Ateneo per tutti gli accordi stipulati digitalmente
daltUniversita Ca’ Foscari Venezia.

A fal fine, allinizio di ogni anno si prowedera a richiedere a tutte le sirutiure
delfAteneo (Uffici dellAmministrazione centrale e Strutture decentrate quali Dipartimenti,



Scuole, Biblioteche, Centri) di comunicare entro un congruo termine il numero di accordi
stipulati digitalmente nel corso del precedente anno solare e 'ammontare dellimposta di
bollo ad essi riferibile ai sensi della normativa vigente (DPR 642/1972 e ss.mm.ii.).

Una volta raccolte dette informazioni, 'Ateneo provvedera al versamento telematico
dellimposta di bollo in maniera unitaria (di norma utilizzando il Mod. F24 telematico).

Ca'roscari IMPOSTA DI REGISTRO

Venezia

Servizi Istituzionali La Cirgo_larg n. 5§/E d.el' 17 o’ftobre’ 2008' dell’Agen%?a delle Eintraj(e - Direzi-ong

(Sist) . Centrale Servizi ai Contribuenti, in merito allassolvimento dellimposta di registro per gli atti
N ) ‘ stipulati digitalmente prevede che il pagamento dellimposta avvenga: “.. mediante

Utficio AffariLegali  presentazione ad un ufficio dell/Agenzia delle Entrate del modello di richiesta di registrazione

(Mod. 69), allegando allo stesso il supporto di memorizzazione (es. CD o DVD) dellatto
firmato digitalmente dai contraenti, unitamente ad un esemplare in formato cartaceo. Ai fini
dellindividuazione del termine per la richiesta di registrazione, il_documento_informatico
dovra essere munito di marcatura temporale al momento dell'apposizione, a cura delle parti,
dellultima firma digitale. Allo scopo di semplificare il controllo dell ufficio sull avvenuto rispetto
del termine, é auspicabile che la data del contratto coincida con quella risultante dalla marca
temporale. Alla richiesta di registrazione, che puo essere eseguita presso qualsiasi ufficio
Ca' Foscari dallAgenzia delle Entrate, le parti debbono unire la prova dellavwenuto pagamento
2353 gd\ gﬁi ij@ dellimposta di registro. ..”
- ’ in concreto, 'assolvimento dellimposta di registro per gli accordi stipulati digitaimente
T +39 041234 8040 tra Universita e altre Pubbliche Amministrazioni, se dovuto ai sensi del D.P.R. 26 aprile
/8253/8296 1986, n. 131 e successive modifiche e integrazioni, dovra avvenire presentando al
;Jfgggiiiﬁig competente Ufficio dellAgenzia delle Entrate: a) la richiesta di registrazione su apposito
' - ‘ modello (Mod. 69, scaricabile dal sito web dellAgenzia delle Entrate) da presentare in
duplice copia; b) il supporto informatico dove & stato memorizzato l'accordo stipulato
Cod. Fisc. 80007720271 digitalmente (CD o DVD); ¢) una copia cartacea dellaccordo stipulato; d) ricevuta di
pagamento dellimposta di registro (da effettuarsi di norma utilizzando il Mod. F23, anchesso
scaricabile dal sito web dellAgenzia delle Entrate).
A differenza di quanto previsto per limposta di bollo, ragioni di efficienza ed
economicita fanno ritenere pit funzionale che ciascuna singola struttura dellUniversita
provveda autonomamente allassolvimento dellimposta di registro per detti atti.

Alla luce di quanto sopra esposto, si segnala la necessita che tutte le strutture
dellAteneo si adeguino alle suindicate modalita di assolvimento delle imposte di bollo e di
registro per gli accordi stipulati digitalmente con altre Pubbliche Amministrazioni.

Si segnala infine la necessita che tutte le strutture dellAteneo si adeguino altresi alle
istruzioni operative contenute nellapposito documento predisposto dallArea Servizi
Informatici e Telecomunicazioni (ASIT) in merito alla sottoscrizione digitale degli accordi in
oggetto (Allegato n. 1). :

Per ogni eventuale ulteriore informazione o chiarimento, sara possibile rivolgersi
ali'Ufficio Affari Legali (dott. Carlo De Martin Fabbro, tel. 8296 - 8253), per gli aspetti tecnico-
giuridici relativi allassolvimento delle suddette imposte, e alfArea Servizi Informatici e
Telecomunicazioni ~ ASIT (dott.ssa Donatella Marvulli, tel. 7154) per gli aspetti relativi alla

firma digitale.
Cordiali saluti
Il Direttore] Generale
In @e@g Scuttari
Allegaio cs.
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Istruzioni operative per la Firma Digitale
dei documenti informatici
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Firmare digitalmente un documento

Secondo le indicazioni dell Agenzia per I'ltalia Digitale & possibile firmare digitalmente un
PDF utilizzando due diverse modalita: la Firma CAdES (CMS Advanced Electronic
Signatures), che produce un file “p7m” e la Firma PAdES (PDF Advanced Electronic
Signatures), interna al PDF.

Con entrambe le modalita € necessario essere in possesso di una Firma Digitale
Elettronica avanzata, emessa da un Ente Certificatore tra quelli accreditati dall'Agenzia
per I'ltalia Digitale.

L’Ateneo fornisce, su richiesta, una Firma Digitale di tale natura, emessa da Infocert S.p.A.




Richiesta Firma Digitale

Per richiedere la Firma Digitale e sufficiente:

e stampare il modulo che si trova nell’area riservata di ca’ Foscari seguendo il percorso:

Didattica > Verbali telematici > “Richiesta / Rinnovo online” della Firma Digitale

¢ Firmare in ogni sua parte il modulo
o Allegare fotocopia del documento d’identita citato nel modulo e del codice fiscale

e |nviare il tutto a:

Ufficio Firma Digitale

c/o ASIT

Universita Ca’ Foscari Venezia
Dorsoduro 3246

30123 Venezia

Italia




Primo utilizzo della Firma Digitale su chiavetta BusinessKey Infocert
Mac OsX: Non é richiesta alcuna installazione

Windows:
Inserire la chiavetta in una porta USB

Attendere il completamento dell’eventuale procedura automatica di installazione (pop up in basso a
dx, vicino orologio di sistema).

Aprire “Risorse del computer” (in - e b T
Windows XP) o “Computer” (in B eme g O
Windows Vista, 7, 8) | Dasmeni | PR -

Spazic disporsibite

Oiscg tocete (03 Dati (O

1
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|

Ao »

.1 Disposith can achive nenoski () . =

2%
¥ B svsressiey o

Percnree dr ceta 1) . e

Fare un doppio clic su “Business
Key Lite” (a volte & “Picodisk”)

Unitd DVD RW (F:

Dovrebbe aprirsi I'applicazione omonima che permette di
gestire la Firma Digitale Infocert (se compare una lista di
files fare doppio clic su “autorun.exe”).

Espandere la voce “Gestisci BusinessKey Lite" —Y

/

Doppio clic su “Installa i driver di BusinessKey Lite sul tuo

PC” ﬁw

% Hoczs DB b et A BB a g L bll sincss

Gy T e st s ~ &= -

G Teponta f shconic PPE S Bt naatr g ife LITE

Installare il software accettando ia licenza proposta.




Firma Digitale in formato CAdES

Windows

La chiavetta BusinessKey contiene al suo interno un programma per la firma digitale, ma e
consigliabile installare ed utilizzare il software Dike, scaricabile gratuitamente dal sito della Infocert
all'indirizzo:

https://www.firma.infocert.it/installazione/installazione DiKe.php

Inserire la chiavetta in una porta USB

Attendere il completamento dell'eventuale procedura automatica di installazione (pop up in basso a
dx, vicino all'orologio di sistema).

Aprire il programma Dike, precedentemente installato

Cliccare su "Seieziona File” e scegliere ii file da firmare.

o % B e Marca

Seleziora e ualizzadeciments

Cliccare su “Firma”

Scegliere il nome del file e la cartella dove salvarlo.

Inserire il PIN quando richiesto.

Comparira un messaggio di avvenuta operazione.

If file firmato digitalmente con questa modalita acquisisce una estensione “p7m’.

6




-Mac OsX 10.5.8 e succ.

Inserire la chiavetta in una porta USB.

Attendere la comparsa dell'icona relativa sul desktop (“BusinessKey” oppure

“Picodisk”).

Fare un doppio clic sull'icona comparsa, e poi sulla cartella “Mac”.

Scegliere e lanciare con un doppio clic la
versione di “DikeX Lite” adatta al proprio
sistema operativo, eventualmente cercandola

chiavetta.

y i " ﬁm !
anche nell'altra cartella “Mac” presente nella B

M&mﬁun &

TERERLITe Dk XLs10.§ Porabie Faefan

 SESEEER
23 sonanis

Compare un “DropBox” in alto a sinistra.

# DikeXLite File Documento Opzioni  Finestra Aiuto

i ORECK I

Trascinare il file da firmare sul “DropBox”: si apre una finestra che riporta un’anteprima del file e

alcune icone di comando.

Cliccare su “Firma”, scegliere la cartella in cui salvare
il file firmato e proseguire inserendo il PIN quando
richiesto.

# DikeXLite File Documento Opzioni Finestra Awto
P ——————————— R R .
Srors& AN [Users/cs
. <

i s Firma  Fira & Marca

fusersfesitafDeskiopfprova.
352

Il file firmato digitalmente con questa modalita acquisisce una estensione “p7m”.




Verifica della firma apposta su un documento in formato CAdES
(estensione “p7m”)

Windows

Aprire il programma Dike, precedentemente installato.

Cliccare su “Seleziona File” e scegliere il file da controllare.

" DMEPOE + Digutat Kay - Versione § 31 - 3 —'H
fin e amere Ak
y 5 3 —~

J_.A.,.,,k - J' - / | Freg o v s ’.J Coantaa [ - |vwn | )—l., 9 Gundls ‘,-’5,.

Flire seletionato: C:' Users' marvalli Desktop'provaF irme.pTm
= A

. kY

Dot nis Frwe
vt p T
RIS e . l) 510 e A 1ie CORLATEL LA MAR L L wdol oot Tommg Cuallcots MYV
. - chece Qu
era e

InboCent 8 p.A = Arewsinne: Nefvnn Lettore di Smaartl ard coliegate

Cliccare su “Verifica”: compariranno le informazioni relative ad ogni firma apposta al documento.

Per visualizzare il documento:

Cliccare su “Visualizza”

Si aprira il lettore di PDF installato nel computer (generalmente Acrobat Reader) con il documento in
oggetto.




Firma Digitale in formato PAJES
Inserire la chiavetta Infocert con i certificati di Firma Digitale in una porta USB.

Aprire il file PDF con Acrobat Reader.

Cliccare sulla voce “Firma” oppure “Compila e
Firma” del menu strumenti visibile a destra (se |l
menu non é visibile: menu Vista> Firma)

Cliccare su “Utilizzare i certificati”, ultima voce dell’elenco che
compare

Cliccare su “Firma con certificato”

Seguire le istruzioni:

Zi) insesisei firmna

- cliccare su “Disegna nuovo rettangolo di firma”

- individuare una zona del documento in cui far comparire i dati della v lnvia o raccogi firme

firma digitale

- il cursore diventa una croce: posizionarsi nello spigolo in alto a sx

dell'area scelta e trascinare il cursore nell’angolo in basso a dx

Compare una finestra per la gestione dei dati da g S e,
pubblicare nel file: usando la voce “Aspetto” & possibile | s connome: o b ot s St 001
scegliere gli elementi da includere nella dicitura finale. it cnficne ntoCer Fea e oo :
, Gorseo Y ramion o / ;
Frmag gt 3 LosIMt:
Una guida alle varie opzioni & disponibile cliccando sul Donate”a%?f‘%~< Ry
punto di domanda. : Marvulli
| Elorcs docurmenta dopo ta hrrna »
Cliccare sul pulsante “firma”: viene richiesta la posizione e R e et
il nome del nuovo file.

ATTENZIONE, a differenza della firma con Dike, la firma su PDF non cambia l'estensione del file,
che rimane PDF: e necessario modificare il nome del file stesso per evitare di sovrascrivere
l'originale.

Inserire il PIN quando richiesto




Verifica della firma apposta su un PDF in formato PAdES

Aprire il file PDF con Acrobat Reader

i N wp=: ] . E Fyme @
Cliccare sull'icona “Firma” che compare sulla sinistra %
del documento

'  Convalide tut

(43 Rew 1: firmato da Dosateila Marvulh
Firma valids:

Bocumento non & stato modificate dopo Fapp

. . " | Firmato dall' utente corrente

Compare la lista delle firme presenti nel documento i f 4 , AL
; L'ora dells firma proviene dalt orologio del corr

| i Firmna abilitata per convalida a fungo tenmine

, .. .. .. ! ; Z Dettaghi firma

E pOSSIb_IIe.espa.ndere qgm riga per avere magglorl ! Dettaghi centificato

informazioni sul firmatario e sulla validita della firma ' Y Ukirmo controllo: 2014.10.20 16:46:32 + 0206

Campo: Signature? a pagina 1

rod | H Fare clic per visualizzare questa versione

Cliccando su “Dettagli certificato” € possibile controllare I'Ente Certificatore che ha emesso la Firma
Digitale

ATTENZIONE: con questi strumenti € possibile crearsi una propria Firma con Certificato, la cui

identita non é certificata da nessuno!

Controllare sempre che ’Ente Certificatore sia accreditato. ..

U2 Et0re Cerhifical

Quests fi di diadoge o vesialt Fdettagh & un cortificato o dell inters catena di emision
fettagh corrispondons sl voce veb it

{7 Mosten tutti § percorst i cendicazione travatt

Ermessa dar  fofoCart firms Cuatdizats <fema, digitedadocen 4>

A P T A A BN IVET ] O o S AT N S R Pt 1n i o consente df vissaliazace | dettagh & un cortificat « delinteva catena & erivg |
Infelen Fisrma Cusli : Riepiego  Dattagh | Revocs | AHfidabilits | Poley | Notaleqate S s voce selerionata, ;
R i & retificaziong trowath
=1 Cronatetts Flarcuily H

THFOCERT SPAGTIA521 006 aaahficste { ?mp&c{ja MA&;&( R?—YGCK o Athdabiitd Poff{‘y 3 ’;‘ic!j i&g&it K

/

HAFGUERT SRA

Valide das 20TLTVTE 174820 £ 0100 Coesto cemficsts & considersto Mdagdte par:

Yalido fine ot 2015711715 920000 - 5200 ¥ Fiemna docurend ¢ datl

H

Htdizze:

¢ i
| |
i i H

Fitrna dotuments Sy .
Tentfua docurent

Egegat oentanutg: e
e n

Pucr moorponto m ur documento
o Beegui nadargt con privites dlevatt incorporats 0 an
anturnents (e et

R Do cperanoms & satems con poniedgs (operanan 4 rete,
ctarags, sccesse 3cfde, £ 05 ved)
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Formato PDF/A

Il PDF/A é un particolare formato sviluppato per I'archiviazione nel lungo periodo di documenti
elettronici: si tratta di un sottoinsieme del PDF che assicura la riproducibilita dei documenti nel futuro
esattamente come nel momento della loro creazione.

Il formato PDF/A e regolamentato dallo standard ISO 19005-1:2005.

Caratteristica principale del PDF/A & che i documenti incorporano al loro interno tutte le informazioni
necessarie per la visualizzazione, in modo da essere autoreferenziali

[http.//it. wikipedia.org/wiki/PDF/A]




Creazione PDF/A-1 con Office Word (v2007 e succ.)

Aprire il documento da trasformare

)

Satva

Scegliere la voce “Salva con nome” e il
ﬁpO: “PDF” . Stamipa
Prepars
: Inviz

Puhbiica

g
3 ¢ Chiudi
-

Salva cot nofe

Satvataggio f una copia del dotumento

Docomento di Wind
onsente di sshvare il file come datumentn Ward,

Modelio di Wosd

Consente di sabrare i} gncumento come modells utifizzabite
per formattare document] Yutur,

% Documento dif Word 97-2003

Cansente oi salvare una capia del dooumanto completamente
compatibite con Word 972003,

Testo Openocument

Sabea il document nel formato OpenDocument,

POF 0 XPY
Consente @

4 L‘L'-'a" uny copia del documents come flie

At formati
Corsente di aprire fa finestrs di dislogo Salva con nome per
selezionare tra tutti § tipi di file possibili,

Crganizzs # Huese carlelfa

Risorse recenti 4 s

& Raceolte
¥ Documenti
H B Immagini
Q; Musica ot

B Video

;B Computer
& Disco tocale (G}

Nella scheda che si apre inserire
il nome che si vuol dare al
documento e fare clic su
“opzioni”

W Rete

Nowte fila 2

Attivare il segno di spunta
“‘Conforme a ISO 19005-

& Nascondi cardelle

Salva come: ‘PDF {“-pdﬁ 0

Rl

=~ f Vhormate | ¥ Messuna..

erko per [Accesss Faciato

orforme a 150 19005-1 (FOF{AY
as5to bitmans 5o+ tipl & carsttare Non POssON0 Kssare Ktorporsty

f‘ Oprioni;

Titelo 1

Strumenti v Pu,bb‘!“

1(PDF/AY’

Clic su “Ok”
Clic su “Pubbilica”

12
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Creazione PDF/A-1 con OpenOffice

Aprire il documento da trasformare

Scegliere la voce “Esporta nel formato PDF”

Intervalo
%) Tutto
{0 pagine
% Compressione senzs perdite
%) Compressione PEG

Nella scheda che si apre attivare il segno di Oualits

spunta su “PDF/A-1a” [ Ridud risoluzione immagine

Clic su “Esporta” ] Esporta seg
[ Esporta i commenti

[} Esporta pagine yuote inserite automaticamente
[l Cres un Be brido

[
Lad




Creazione di PDF/A con PDFcreator (v1.6 e succ.)

Attenzione: attualmente i file prodotti con il PDF Creator non rispecchiano lo standard
PDF/A 1a o PDF/A 1b, ma lo standard PDF/A 2, che non viene accettato da alcune
amministrazioni: NON utilizzare questo programma

14




Creazione di un PDF/A con PDF24 Creator

Installare il programma

Stampa E

Foxkt Fleader POF Parter

Foxk Reader POF Printer
HP Officeist 5000 £608a
© ikhwvia a Oneblote 2013

: i Microsoft APS Document Witter

Aprire il file da convertire e stamparlo scegliendo
come stampante “PDF24 PDF”

=

b

% PDF24 Assistant - riassuntoOperazioniv0.. = =
" CLONAMI!
s
Quahta massima - 5
Crei una sua
Nella finestra che si apre cliccare su “Salva Salva FOF versione
Come....” Invia POF via fax con il suo
Invia PDF via email banner:
alva come,.. warw.pdf24.org
Modifica PDF o
Apri POF ;. .
Anteprima N g_ -
T e
ks ‘I" I:I"-‘ ""1::3:.- -:ﬂ '.‘
SO e o
|




Scegliere la voce “PDF/A - 17 e impostare il “Modello Colore” a “CMYK”

Scegli il formato: PDF - Portable Document Format
» PDF Generale
* Generale
s Informazioni . ; :
o Sicurezza © Quahitd del file POF Qualita buona v
» Filigrana , ; \ - '
e Firma POF standard
s Carta . . .
s Risoluzione - Rotazone automabica
+ Compressione . pagne
* Font . Modelio colore
* POF/X
* PDF/A Ottimizzato per il web
» P :
= EPS iy
» PCL Informazioni

Cliccare su “Continua”

Scegliere dove salvare il file e proseguire.
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Conversione di un file PDF nel formato PDF/A-1 con PDF24 Creator

Aprire il programma. B R PDF2A Creaton - 2N

g Fite wodifics Visocalizza Strument Guda o lirea

g =

~

Canedy % L vandlient-wins
Scegliere il file PDF da convertire 91 Dmsecn 02 gucatimacigtaiez
© ) Archove P 03-guidafirmadigitale2
» 37 Preferti 1 Acrabar_DigSig_Woriil

tF

‘&3 Documertt

ﬁallegntomomune—verm
Rizorse del camputer 4

allegato-comune-vecon

rticorruzione _honacs
# nticorruzione _bonaccer,
frochale -

M anticornumione_banac
T;5@arst«'z::':rruzi:me_t__ SCC
1N antcorruzions_tonsce

Pragram Files {x86)
Usarg

Cliccare su: “File > Salva Come”

E:

Risarvato per if sistem:
basa (G}

struments (M}

84

Scegliere la voce “PDF/A - 1" e impostare il “Modello Colore” a “CMYK”

s i Proprieta formato

Scegli il formato: ~ PDF - Portable Document Format

= PDF  Generale

+ Generale
-« Informazioni . .

4 Sicurezza Qualita del file POF ‘Qualita buona v
; « Filigrana | e G S,
i s Firma ~ PDF standard PDE/A-1 .,ﬁ
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Cliccare su “Continua”

Scegliere dove salvare il file e proseguire.




Conversione di un file PDF nel formato PDF/A-1 con OpenOffice

1) Installare in Open Office I'estensione gratuita: PDF Import for Apache OpenOffice; (Oracle PDF
Import Extension per le versioni precedenti alla v4)
a. Scaricare l'estensione dal sito: http://extensions. services.openoffice.org
b. Menu “Strumenti” > voce “Gestione Estensioni”
¢. Clic su “Aggiungi”, in basso nella finestra
d. Seguire le istruzioni

2) Clic col tasto destro del mouse sul PDF da convertire > “Apri con” > “OpenOffice Writer”

Ultimyy modfics Tigo Sirensione
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Copia &
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Elimina

: Rinoming
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i Cahegameé?i :
Generale  °  Visualizzazione inizi
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*: Tutto

3) Dal menu “File” > “Esporta come PDF”

4) Attivare il segno di spunta su “PDF/A-1a”

5) Clic sul puisante “Esporta”

i Esponta segoakbii

{7 Espona » commentr




. Verificare se un file @ in PDF/A

Attualmente non esistono programmi gratuiti affidabili che permettano di controllare con certezza se
un documento rispetti il formato PDF/A.

E’ comunque possibile controllare ogni file utilizzando il sito:
http://www.pdf-tools.com/pdf/validate-pdfa-online.aspx

Tootscom & ;

PIF Tools » Progucts § Shep » Produd Overview & Shisp » POE Validatyr » Ontine Yuidalor
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PO EME Convertes

1) Caricare il file da testare con il pulsante “Sfoglia”
2) Clic su “L.oad PDF”

3) Scegliere il formato di controllo

4) Clic su “Execute”

5) Attendere la risposta
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Acrobat Reader e PbFlA

ATTENZIONE: Attualmente il controllo tramite Acrobat Reader non fornisce indicazioni precise
sull’aderenza del file PDF allo standard PDF/A; e utile SOLO per individuare file che sicuramente
NON SONO PDF/A.

Infatti i file riconosciuti come PDF/A dall’Acrobat Reader non sempre superano il TEST del PDF
Validator

(http://www.pdf-tools.com/pdf/validate-pdfa-online.aspx)

NON UTILIZZATE ACROBAT READER PER CONTROLLARE SE | VOSTRI FILE SONO PDF/A

-« . Firmare Digitalmente un _.pdf_a-2b.pdf - Adobe Reader
o Mﬁdn‘xa P T e o T [ ; TRl =LA N S e (e & R s
Ay EITRL T S A , = ; 7
= repenonati 5 F) [P D TSI 2 @] [ ] ] L s
A ' file & conforme allo standard POF/A ed & stato aperto in sola lefturs per evitare modifiche.
4
¢ setta
Firma Dig
e
i Home
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Firmare Digitalimente un PDF/A a porina di Legge

Ak sensi della normativa italiana vigeate, il formate PDF ¢ riconesciute valido per Ia fir
Legge
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Apporre una marca temporale ad un documento firmato digitalmente

La marca temporale permette di associare data e ora certe e legalmente valide ad un documento
inforniatico.

L’'Ateneo fornisce, su richiesta, le credenziali (login e password) per poter utilizzare tale servizio.

Per la marcatura & necessario il software Dike.
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Cliccare sul pulsante “Marca
8 Servizio di Marcatura Temporale ? ‘QL’-;

Inserire login e password e TOGLIERE il segno di spunta

) ) . Credenziab & acoesso ¥ senian & Marcabura Terper sle
alla voce “Salva impostazioni”.

E naceseano satentcaes per accedere af servizio d Marcatura Terporsie.
Digitarn, & sequato, 1D Utente e Pagsword.

<10 Litenter

Passwind:

1 Salva mpostadon

Continuare 'operazione cliccando su “ok”




